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CHAPTER

ONE

INTRODUCTION

mvme is a VME data acquisition solution by mesytec aimed at nuclear physics experiments involving a single
VME controller. The goal of this project is to provide an easy to setup, easy to use, cross-platform data acquisition
system with basic data visualization and analysis capabilities.

Fig. 1.1: mvme overview

1.1 Features

• High-rate, low-latency VME module readout

• Supports the following VME Controllers:

– Mesytec MVLC

* USB3, USB2 and Ethernet connectivity

* Lowest-latency readout, lowest deadtime

mesytec GmbH & Co. KG
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* Flexible Trigger and I/O logic module

* Possibility to use optical fiber based Ethernet via onboard SFP cage

* GBit/s Ethernet connection required if using Ethernet!

– WIENER VM-USB (USB2, readout rates of up to 15 MB/s)

– Struck SIS3153 (Ethernet)

* Readout rates of up to 35 MB/s from a single module.

* Optimized setups can yield around 52 MB/s.

* GBit/s Ethernet connection required!

• Easy creation and configuration of the VME setup

– Multiple event triggers are possible (NIM, IRQ, periodic readout)

– Multiple modules can be read out per trigger

– Flexible VME module setup using configuration scripts

– Not limited to mesytec VME modules

• Live histogramming of readout data (1D and 2D)

• Rate Monitoring of internal system rates and external rates generated from readout data (e.g. scaler modules,
event counters).

• Flexible VME module data extraction using matching and filtering on the bit level

• Graphical analysis UI

• Optional compression of output listfiles

• Replays of recorded listfile data

• JSON-RPC remote control interface over TCP

Allows to remotely start and stop DAQ runs and request status information.

• Export of readout data to ROOT object trees.

• The analysis side is detached from the readout side. This means analysis complexity does not have a negative
effect on readout performance. Instead during a live DAQ run the analysis side will only get as much data
as it can process.

1.2 High-level overview

1.2.1 The VME side

mvme achieves high data rate, low-latency VME readout by using the VME controllers autonomous DAQ mode.
In this mode the controller executes lists of commands (trigger stacks) upon activation of a specific trigger
condition. Data generated by the execution of trigger stacks is buffered and then sent over USB or Ethernet to the
controlling computer.

In mvme the physical VME setup is described as a tree of objects with events as top-level nodes. Each event has
a trigger condition (e.g. Interrupt or NIM) and contains the modules to be read out on every activation of the
trigger.

A module in mvme has a collection of VME Scripts. These scripts contain the module configuration (module
specific parameters, multicast setup, etc.) and the commands required to perform the readout. The readout com-
mands of all modules belonging to the same event are combined to form the trigger stacks uploaded to the VME
controller.
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Fig. 1.2: VME setup with one event containing two modules

The VME setup also describes the structure of the data that is expected to be read out and thus allows the software
to validate the received data stream.

For mesytec modules fully commented initialization files are bundled with mvme and can be loaded as templates.

1.2.2 Analysis

mvme contains an analysis system that allows parameter extraction (e.g. ADC values per channel), calibration,
accumulation and visualization of data both during a DAQ run and while replaying from file. Additionally a set
of built-in operators can be used to perform calculations and transformations on the data as it flows through the
system.
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Fig. 1.3: Analysis UI with MDPP-16 default objects

The structure defined by the VME configuration is also present in the analysis: modules which are read out as a
result of the same trigger condition are grouped together in an event.

The system itself models dataflow from sources, through operators, into sinks. Data is transported in the form of
parameter arrays with each element carrying the parameters numeric value and additional meta information.

Fig. 1.4: Example analysis dataflow

Sources are data extractors that are directly attached to a VME module. A source receives each data word that
was read out from the module in response to a trigger condition. Sources are used to split the data into logical
parts, e.g Amplitude and Time data and to extract the corresponding raw values.

Operators are logic pieces used to perform calculations on the data (e.g. calibrate raw ADC values to voltage).
Operators can have multiple inputs and produce a single output array.

Sinks are data accumulators that do not produce any output parameters. Currently 1D and 2D histograms, a rate
monitor and a file exporter are implemented.

Output parameters of sources and operators can be inspected at runtime. Objects can be added, removed and
modified even while the DAQ or a replay is running. Changes are effective immediately.
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1.2.3 The DAQ process

When requested to start a data acquisition run mvme performs the following steps:

• Initialize the VME controller using information from the VME configuration

• Setup modules using the module VME scripts

• Switch the controller into autonomous DAQ mode

• Repeat until DAQ is stopped:

– Read a data buffer from the VME controller

– Validate the structure of the received data

– Augment the data with mvme specific meta data

– Write data to the listfile (optionally using compression)

– Pass data to the Analysis

• Tell the controller to leave DAQ mode

• Close the listfile

Note: Data acquisition and writing the data to file have the highest priority in mvme. If during a DAQ run the
analysis system cannot keep up with the incoming data rate some buffers will not be passed on to the analysis.

The fraction of processed buffers / total buffers is called the analysis efficiency and is shown in the bottom status
bar of the analysis window. Hovering of the Efficiency number shows a tooltip with detailed buffer counts.

When replaying from file all buffers are passed to the analysis.
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CHAPTER

TWO

INSTALLATION

2.1 System Requirements

• A recent 64-bit Linux distribution or a 64-bit version of Windows 7 or later.

• One of the supported VME Controllers:

– mesytec MVLC (USB3/2, GBit/s Ethernet)

– WIENER VM-USB (USB2)

– Struck SIS3153 (GBit/s Ethernet)

• At least 4 GB RAM is recommended.

• A multicore processor is recommended as mvme itself can make use of multiple cores: readout, data com-
pression, analysis and the user interface all run in separate threads.

2.1.1 Mesytec MVLC

• Firmware updates for the MVLC can be found here: https://mesytec.com/downloads/firmware%20updates/
MVLC/

• When using the MVLC via USB the drivers for the FTDI USB Chip are usually shipped with the operating
system. If your system does not recognize the device you can get the drivers from the FTDI website:
https://www.ftdichip.com/Drivers/D3XX.htm.

Direct link to the driver installer: https://www.ftdichip.com/Drivers/D3XX/FTD3XXDriver_
WHQLCertified_v1.3.0.4_Installer.exe.zip

• Using the MVLC via Ethernet requires a GBit/s network connection.

2.1.2 WIENER VM-USB

• WIENER VM-USB VME Controller with a recent firmware

The VM-USB firmware can be updated from within mvme. See VM-USB Firmware Update for a guide.

• Latest USB chipset driver for your system.

Updating the driver is especially important for Windows versions prior to Windows 10 in combination with a
NEC/Renesas chipset (frequently found in laptops). The driver shipped by Microsoft has a bug that prevents
libusb from properly accessing devices. See the libusb wiki for more information.

• USB Driver: libusb-0.1 (Linux) / libusb-win32 (Windows)

The windows installer can optionally run Zadig to handle the driver installation.
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2.1.3 Struck SIS3153

• The SIS3153 controller requires a GBit/s ethernet connection.

2.2 Installation Steps

2.2.1 Linux

The mvme archives for Linux include all required libraries. The only external dependency is the GNU C Library
glibc. When using a modern Linux distribution no glibc versioning errors should occur.

To install mvme unpack the archive and source the mvme env script which will setup your PATH and
LD_LIBRARY_PATH:

$ tar xf mvme-1.3.0-Linux-x64.tar.bz2
$ source ./mvme-1.3.0-Linux-x64/bin/initMVME
$ mvme

2.2.1.1 MVLC_USB and VM-USB Device Permissions

To be able to use the MVLC_USB or the VM-USB VME Controllers as a non-root user a udev rule to adjust the
device permissions needs to be added to the system.

For the MVLC a udev rules file is contained in the installation directory under extras/mvlc/51-ftd3xx.
rules. Copy this file to your udev rules directory (usually /etc/udev/rules.d/).

The rules file for the VMUSB can be found under extras/vm-usb/999-wiener-vm_usb.rules.

After copying the file reload udev using service udev reload or /etc/init.d/udev reload or
service systemd-udev reload depending on your distribution or simply reboot the machine. The con-
troller also has to be reconnected to your PC for the device permissions to update.

2.2.2 Windows

Run the supplied installer and follow the on screen instructions to install mvme.

2.2.2.1 MVLC USB Driver

If Windows does not recognize the MVLC when plugged in via the front USB and powered in a VME crate,
your Windows installation might be missing the FTDI USB driver. The driver installer can be found on the FTDI
website: https://www.ftdichip.com/Drivers/D3XX/FTD3XXDriver_WHQLCertified_v1.3.0.4_Installer.exe.zip.

A non-installer version is also available on this page: https://www.ftdichip.com/Drivers/D3XX.htm.

2.2.2.2 VM-USB only: Driver Installation

To be able to use the VM-USB VME Controller the libusb-win32 driver needs to be installed and registered with
the device. An easy way to install the driver is to use the Zadig USB Driver Installer which comes bundled with
mvme. You can run Zadig at the end of the installation process or at a later time from the mvme installation
directory.

In the Zadig UI the VM-USB will appear as VM-USB VME CRATE CONTROLLER. If it does not show up there’s
either a hardware issue or another driver is already registered to handle the VM-USB. Use Options -> List All
Devices to get a list of all USB devices and look for the controller again.
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Fig. 2.1: Zadig with VM-USB and libusb-win32 selected

Make sure libusb-win32 is selected as the driver to install, then click on Install Driver. Zadig will generate a
self-signed certificate for the driver and start the installation process.

It is highly recommended to restart your system after driver installation, especially if you replaced an existing
driver. Otherwise USB transfer errors can occur during VME data acquisition!

In case you want to manually install the driver a ZIP archive can be found here: libusb-win32.

2.2.3 Installation from source

The mvme sources are available on github: https://github.com/flueke/mvme

Refer to the README file for a list of required dependencies and build instructions for Linux, Windows and Mac
OS X.

2.3 Ethernet DHCP/ARP setup

When using the MVLC via Ethernet or the SIS3153 controller some network setup has to be done.

The easiest way to get a working setup is if you are running a DHCP server on your network. Both of the
controllers will request an IPv4-Address and a hostname via DHCP after powerup.

The MVLC will request the hostname mvlc-NNNN where NNNN is the serial number shown on the front-panel
near the Ethernet port.

The SIS3153 requests a hostname of the form sis3153-0DDDwhere DDD is the decimal serial number as printed
on the board.

After the DHCP phase the two controllers should be reachable via their hostnames. You can verify this by opening
a command prompt and running

ping mvlc-0010

for the MVLC with serial number 10.

2.3.1 Using a manual ARP entry

In case DHCP with hostname assignment should not or cannot be used an alternative approach is to manually
associate the MAC-address of the controller with an IP-address.
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• Obtaining the controllers MAC-address

The first step is to figure out the controllers MAC-address. This is the serial-number dependent Ethernet
address of the controller.

For the MVLC the MAC-address is 04:85:46:d2:NN:NN where the NN:NN is the serial number of the
MVLC in decimal. So for MVLC-0015 the full MAC-address is 04:85:46:d2:00:15.

The MAC-address of the SIS3153 is 00:00:56:15:3x:xx where x:xx is the serial number in hex-
adecimal. So for my development controller with S/N 42 the serial becomes 0x2a and the resulting MAC-
address is 00:00:56:15:30:2a.

With the MAC-address at hand we can now create an IPv4-address to MAC-address mapping in the operating
systems ARP table.

This step is specific to the operating system and will require root/admin permissions. The below examples asso-
ciate the IP-address 192.168.100.42 with the controllers MAC-address. You have to change the IP-address
to match your local network setup, otherwise the operating system does not know how to reach the controller.

• Creating the ARP entry under linux:

With root permissions an ARP entry can be addded this way:

arp -s 192.168.100.42 04:85:46:d2:00:15

To make the entry permanent (at least on debian and ubuntu systems) the file /etc/ethers can be used. Add a
line like this to the file:

04:85:46:d2:00:15 192.168.100.42

This will take effect on the next reboot (or when restarting the networking services I think).

• Creating the ARP entry under windows:

Open a cmd.exe prompt with administrator permissions and use the following command to create the
ARP entry:

arp -s 192.168.100.42 04-85-46-d2-00-15

To verify that the connection is working you can try to ping the controller:

ping 192.168.100.42

If everything is setup correctly the controller should answer the ping requests.
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CHAPTER

THREE

QUICKSTART GUIDE

The quickstart guide explains how to create a simple setup using the mesytec MVLC VME controller and one
mesytec VME module. The modules internal pulser is used to generate test data. Data readout is triggered by the
module itself using IRQ1 on the VME bus.

Note: In this example an MDPP-16 with the SCP firmware is used but any mesytec VME module should work.
For other modules the value written to the pulser register (0x6070) might need to be adjusted. Refer to the modules
manual and the VME templates for details.

• Start mvme and create a new workspace directory using the file dialog that should open up. This directory
will hold all configuration files, recorded listfiles, exported plots, etc.

• Three windows will open:

– A main window containing DAQ controls, the VME configuration tree and a statistics area.

– The analysis window. As there are no VME events and modules defined yet the window will be empty.

– A log view where runtime messages will appear.
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Fig. 3.1: GUI overview

Press the Settings button in the DAQ Control area and select the correct controller type (MVLC_USB in this
example). Assuming the controller is connected and powered on mvme will automatically find and use it. Also a
message containing information about the controller will appear in the Log View.

3.1 VME Setup

• Select the mvme main window (Ctrl+1) containing the VME Config area.

• Create a VME event:

– Right-click the Events entry in the VME tree and select Add Event.

– Select Interrupt in the Condition combobox. Keep the default of IRQ Level = 1.
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Fig. 3.2: Event Config Dialog

• Create a VME module:

– Right-click the newly created event (called “event0” by default) and select Add Module.

– Select MDPP-16_SCP from the module type list. If you changed the modules address encoders adjust
the Address value accordingly (the address encoders modify the 4 most significant hex digits).
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Fig. 3.3: Module Config Dialog

The VME Config should now look like similar to VME Config tree.

Fig. 3.4: VME Config tree

• Double-click the Module Init entry to open a VME Script Editor window. Scroll to the bottom of the editor
window or use the search bar to search for pulser and adjust the register value for the modules internal
pulser:
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0x6070 1

This line tells mvme to write the value 1 to register address 0x6070. The address is relative to the module
base address.

• Click the Apply button on the editors toolbar to commit your changes to the VME configuration. Close the
editor window.

3.2 Analysis Setup

• Activate the Analysis UI window (the shortcut is Ctrl+2). The event containing the module just created
should be visible in the UI.

• Right-click the mdpp16 module and select Generate default filters. Choose Yes in the messagebox that pops
up. This will generate a set of data extraction filters, calibration operators and histograms for the module.

Fig. 3.5: Analysis UI with MDPP-16 default objects

3.3 Starting the DAQ

Activate the main window again (Ctrl+1). Make sure the VME Controller is shown as Connected in the top part
of the window.
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Fig. 3.6: DAQ control

Optionally uncheck the box titled Write Listfile to avoid writing the test data to disk. If left checked a listfile will
be created for each newly started DAQ run. This listfile is placed in the workspace directory under listfiles.
It is a standard ZIP archive containing the raw readout data and copies of the current analysis setup and the log
buffer contents.

The naming scheme of the listfiles can be adjusted via the Run Settings dialog. Note that mvme will never
overwrite existing listfiles even if you manually adjust the Next Run Number value.

Press the Start button to start the DAQ. Check the Log View (Ctrl+3) for warnings and errors.

In the Analysis UI double-click the histogram entry called amplitude_raw (bottom-left corner in the L0 Data
Display tree) to open a histogram window.

If data acquisition and data extraction are working properly you should see new data appear in the histogram. Use
the spinbox at the top right to cycle through the individual channels.
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Fig. 3.7: Amplitude histogram

You can pause and/or stop the DAQ at any time using the corresponding buttons at the top of the main window.

3.4 Event Counter readout

Optionally a second event used to read out the modules event counter registers can be created. This event will be
triggered periodically by the VME controller.

• Right-click Events, choose Add Event

• Set Condition to Periodic and the period to 1.0s

• Right-click the newly created event, choose Add Module

• Select MesytecCounter as the module type

• Enter the same address as used for the MDPP-16 above
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CHAPTER

FOUR

REFERENCE

4.1 DAQ / Replay controls

Fig. 4.1: DAQ controls

The effects of the buttons depend on the current mode - DAQ or replay - and the current state of the system:

Table 4.1: DAQ control actions
Action DAQ mode Replay mode
Start

• Run DAQ startup procedure
• Open new listfile

Start replay from beginning of file

Stop
• Run DAQ stop procedure
• Close listfile

Stop and rewind to beginning of
file

Pause
• Leave DAQ mode
• No special procedures are

run

Pause replay

The Start button allows to choose what should happen with existing histogram data. Selecting Clear will clear all
histograms in the current analysis before accumulating new data. Using Keep allows to accumulate the data from
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multiple replays or DAQ runs into the same histograms.

The Reconnect button will attempt to reconnect to the current VME controller.

If Write Listfile is checked a new output listfile will be created when starting a DAQ run. The file will be created
in the listfiles subdirectory of the current workspace. The filename is based off the current timestamp to make it
unique.

Use the Compression drop down to switch between a fast compression mode (ZIP level 1) and no compression at
all (ZIP level 0). Even without compression the raw readout data is still placed in a ZIP archive together with the
analysis and log buffer contents.

Note: testing showed that higher compression levels did not yield a significant increase in data reduction but had
a high performance impact so the higher level modes are not currently selectable via the GUI.

Use the Run Settings button to change settings regarding the naming scheme of the listfiles produced during DAQ
runs.

The Workspace Settings dialog allows setting the experiment name (used by the ‘Event Server’ component) and
enabling/disabling the JSON-RPC and Event Server components.

4.1.1 Replaying from listfile

To replay data from a listfile use File -> Open listfile and choose a .zip or .mvmelst file.

When opening a listfile the VME config included inside the file is loaded and will replace the current config. The
global mode will be switched to Listfile. To go back to DAQ mode use File -> Close Listfile.

4.2 VME configuration

4.2.1 Structure

The VME configuration in mvme models the logical VME setup. Modules that should be read out as a result of
the same trigger condition are grouped together in an Event:

Event0
Module0.0
Module0.1
...

Event1
Module1.0
Module1.1
...

The type of available trigger conditions depends on the VME controller in use. With the WIENER VM-USB the
following triggers are available:

• NIM

One external NIM input

• IRQ1-7

The standard VME interrupts

• Periodic

VM-USB supports one periodic trigger which is executed every n * 0.5s (Period) or on every m-th data
event (Frequency). If both values are set both internal counters are reset on each activation of the trigger.
Refer to section 3.4.3 of the VM-USB manual for details.
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4.2.2 Module and Event configuration

The module and event configuration is done using VME scripts which contain the commands necessary to initialize
and readout each module.

At the module level the following phases are defined:

• Reset

Reset the module to a clean default state.

• Init

Setup the module by writing specific registers.

• Readout

The code needed to readout the module whenever the trigger condition fires.

The event level distinguishes between the following phases:

• Readout Cycle Start / End

Inserted before / after the readout commands of the modules belonging to this event. The Cycle Start script
is currently empty by default, the Cycle End script notifies the modules that readout has been performed.
By default this is done by writing to the multicast address used for the event.

• DAQ Start / Stop

Executed at the beginning / end of the a DAQ run. The purpose of the DAQ Start script is to reset module
counters and tell each module to start data acquisition. DAQ End is used to tell the modules stop data
acquisition. By default both scripts again use the multicast address of the corresponding event.

4.2.2.1 Variables

Since mvme-0.9.7 both event and module configs can contain a set of variables whose values can be used inside
VME scripts.

Variables from the event scope are available inside the event scripts and all child module scripts. Variables defined
at module scope are available to the module init and readout scripts. Module variables override variables defined
at event scope.

When adding a new VME event a set of standard variables is created:

• sys_irq

A system variable which is automatically set to the IRQ value used to trigger the event or 0 if the event is
not IRQ triggered.

• mesy_mcst

Contains the highest 8-bits of the VME multicast (MCST) address setup for the event. This is used to
initialize the events member modules and to simultaneously write each of the modules readout_reset register
at the end of each readout cycle.

• mesy_eoe_marker

EndOfEvent marker for mesytec modules (register 0x6038).

• mesy_readout_num_events

Number of events to read out from each module per readout cycle. This is used to set the values of
the irq_fifo_threshold (0x601E) and max_transfer_data (0x601A) of mesytec mod-
ule. By default irq_fifo_threshold is set to mesy_readout_num_events + 1.

The default VME templates shipped with mvme assume that the above variables are defined and contain valid
values for mesytec modules.
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In the GUI variables can be viewed, added and modified by editing the respective object (Edit Event Settings for
events, Edit Module Settings for modules).

For event configs there is also a special variable editor available via the Edit Variables action button or context
menu entry. This editor allows to edit variables during a DAQ run and automatically executes VME scripts that
are affected by changes to variable values.

Fig. 4.2: Event Variable Editor with system and custom variables

4.2.3 DAQ startup procedure

• Reset and setup the VME controller

• Assemble readout code from configured Events

For each Event do:

– Add Cycle Start script

– For each Module:

* Add Module readout script

* Add “Write EndMarker” command (0x87654321, not needed for the MVLC)

– Add Cycle End script

• Upload the readout code to the controller and activate triggers

• Execute global DAQ Start scripts, including the MVLC Trigger/IO script

• Initialize Modules

For each Event do:

– For each Module do:

* Run Module Reset
mesytec GmbH & Co. KG
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* Run all Module Init scripts

– Run the Events Multicast DAQ Start script

• Set the controller to autonomous DAQ mode

Control is handed to the VME controller. mvme is now reading and interpreting data returned from the controller.

4.2.4 DAQ stop procedure

• Tell the VME controller to leave autonomous DAQ mode

• Read leftover data from the VME controller

• Run the DAQ Stop script for each Event

• Execute global DAQ Stop scripts

4.2.5 VME Controller specifics

4.2.5.1 Mesytec MVLC

To implement periodic events on the MVLC the global MVLC Trigger/IO script is modified by mvme when
starting a DAQ run: A StackStart unit is connected to a Timers unit which is setup with the parameters from the
corresponding periodic event. The StackStart unit is then setup to start the command stack for the respective event.
These changes are visible in the MVLC Trigger/IO gui immediately after starting the DAQ.

4.2.5.2 SIS3153

If using the SIS3153 VME controller additional commands which activate Lemo OUT2 during execution of the
readout will be added to the script for the main readout event. The main event is considered to be the first non-
periodic event defined in the VME configuration.

OUT1 and LED_A are activated prior to entering autonomous DAQ mode and deactivated after leaving DAQ
mode.

4.3 VME Scripts

4.3.1 Overview

VME Scripts are plain text files with one command per line. Comments may be started using the # character.
They extend to the end of the line. Alternatively blocks can be commented out starting with /* and ending with
*/.

Scripts belonging to a module (Module Init Scripts, VME Interface Settings, Module Reset and the readout
code) will have the module base address added to most of the commands. This allows writing scripts containing
module-relative addresses only. Exceptions are the writeabs and readabs commands which do not modify their
address argument. The base address can also be temporarily replaced with a different value by using the setbase
and resetbase commands.

The commands below accept the following values for address modifiers and data widths:

Table 4.2: VME Address Modes
Address Mode (<amode>)
a16
a24
a32
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Table 4.3: VME Data Widths
Data Width (<dwidth>)
d16
d32

The combination of amode, dwidth and BLT/MBLT yields a VME address modifier to be sent over the bus.
Internally these non-privileged (aka user) address modifiers will be used:

Table 4.4: VME address modifiers used by mvme
amode single BLT MBLT
A16 0x29
A24 0x39 0x3b
A32 0x09 0x0b 0x08

Numbers in the script (addresses, transfer counts, masks) may be specified in decimal, octal, hex or floating point
notation using the standard C prefixes (0x for hex, 0 for octal). Additionally register values may be written in
binary starting with a prefix of 0b followed by 0s and 1s, optionally separated by ' characters.

Example: 0b1010'0101'1100'0011 is equal to 0xa5c3

4.3.2 Commands

4.3.2.1 Writing

• write <amode> <dwidth> <address> <value>

• writeabs <amode> <dwidth> <address> <value>

writeabs uses the given <address> unmodified, meaning the module base address will not be added.

There is a short syntax version of the write command: if a line consists of only two numbers separated by whites-
pace, a write using 32-bit addressing (a32) and 16-bit register width (d16) is assumed. The address is the first
number, the value to be written is the second number.

Example: 0x6070 3 is the same as write a32 d16 0x6070 3

4.3.2.2 Reading

• read <amode> <dwidth> <address>

• readabs <amode> <dwidth> <address>

Reads a single value from the given <address>.

readabs uses the given <address> unmodified, meaning the module base address will not be added.

4.3.2.3 Block Transfers

mvme supports the following read-only block transfer commands:

• blt <amode> <address> <count>

• bltfifo <amode> <address> <count>

• mblt <amode> <address> <count>

• mbltfifo <amode> <address> <count>

• mblts <amode> <address> <count> (MVLC only)
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blt and bltfifo transfer <count> number of 32-bit words, mblt and mbltfifo transfer 64-bit words.

The *fifo variants do not increment the given starting address.

mblts stands for MBLT swapped and is the same as MBLT but swaps the two 32-bit words in each transferred
64-bit word. It is only supported by the MVLC.

Note: For the MVLC there is no difference between the FIFO and non-FIFO block reads. FIFO mode only
makes a difference if the controller interrupts the block transfer after a fixed number of cycles (usually 256) and
then starts a new block transfer either from the starting address (FIFO) mode or from the incremented address
(non-FIFO mode). The MVLC performs block transfers without interruptions which means the starting address is
transmitted only once and it is up to the individual module how it handles the block transfer.

4.3.2.4 Miscellaneous

wait

• wait <waitspec>

Delays script execution for the given amount of time. <waitspec> is a number followed by one of ns, ms or s for
nanoseconds, milliseconds and seconds respectively. If no suffix is given milliseconds are assumed.

Note: The wait command is only available when directly executing a script from within mvme. It is not supported
in command stacks for the MVLC and SIS3153 controllers.

The VMUSB has limited support for the wait command in command stacks with a waitspec resolution of 200 ns
and the maximum possible delay being 51000 ns.

Example: wait 500ms # Delay script execution for 500ms

marker

• marker <marker_word>

The marker command adds a 32-bit marker word into the data stream. This can be used to separate data from
different modules.

setbase/resetbase

• setbase <address>

• resetbase

These commands can be used to temporarily replace the current base address with a different value. setbase sets a
new base address, which will be effective for all following commands. Use resetbase to restore the original base
address.

write_float_word

• write_float_word <address_mode> <address> <part> <value>

The write_float_word command is a helper function for dealing with VME modules using IEEE-754 floating point
numbers internally (e.g. the ISEG VHS4030). The command writes a 16-bit part of a 32-bit float into the given
register without performing any integer conversions.

Arguments:
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• address_mode

The VME address mode: a16, a24 or a32

• address

Address of the register to write to.

• part

One of upper / 1 and lower / 0. The upper part contains the 16 most significant bits of the float, the lower
part the 16 least significant bits.

• value

The floating point value using a . as the decimal separator.

Example

write_float_word a16 0x0014 upper 3.14
write_float_word a16 0x0016 lower 3.14

Writes the 32-bit float value 3.14 to the two 16-bit registers 0x14 and 0x16.

print

Prints its arguments to the log output on a separate line. Arguments are separated by a space by default which
means string quoting is not strictly required.

Example

print "Hello World!"
print Hello World!

4.3.2.5 VMUSB specific

• vmusb_write_reg (<register_address>|<register_name>) <value>

• vmusb_read_reg (<register_address>|<register_name>)

These commands only work when using the WIENER VM-USB controller and allow read/write access to its
internal registers. For details on the registers see the VM-USB manual section 3.4 - Internal Register File.

Instead of using register addresses some registers are also accessible via name. The following name mappings are
defined:

Table 4.5: VMUSB Register Names
Register Name address
dev_src 0x10
dgg_a 0x14
dgg_b 0x18
dgg_ext 0x38
sclr_a 0x1c
sclr_b 0x20
daq_settings 0x08
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4.3.3 Floating Point Values, Variables and Mathematical Expressions

Since mvme-0.9.7 VME scripts support evaluation of numerical expressions and can contain references to vari-
ables. Additionally floating point values can be used where previously only unsigned integers where allowed.

It is up to each specific command how floating point values are interpreted and what limits are imposed. The VME
read and write commands use mathematical rounding and test that the resulting value fits in an unsigned 16 or 32
bit integer (depending on the commands data width argument). On the other hand the write_float_word command
uses the floating point value directly without performing an integer conversion.

4.3.3.1 Variables

The variable system in VME Scripts is based on simple string replacement. Whenever a variable reference of the
form ${varname} is encountered the value stored under the name varname is looked up and is used to replace
the variable reference. Variable expansion is currently not recursive so ${${foo}} will try to look up the value
of a variable named ${foo}.

Variables are stored in lists of symbol tables with the variables from the first (innermost) table overriding those
defined in the outer scopes.

Each object in the VME Config tree carries a symbol table: VME Events, VME Modules and VME Script objects
each have a set of variables attached to them. When parsing a VME script the list symbol tables is assembled by
traversing the VME Config tree upwards towards the root node. Each objects symbol table is appened to the list of
tables. This way variables defined at script scope take precedence over those defined at module scope. The same
is true for module and event scopes.

In addition to variables defined by VME Config objects variables can also be locally defined inside a VME Script
using the set command. The variable will be entered into the most local symbol table and will override any other
definition of a variable with the same name.

The mvme GUI currently contains a dedicated editor for variables defined at VME Event scope. Select an event in
the VME Config tree and click the Edit Variables button above the tree. Module level variables can be accessed
via Edit Module Settings from the context menu. A dedicated editor for Module and Script objects is going to be
added in the future.

Example

set threshold 500
write a32 d16 0x1234 ${threshold} # -> write a32 d16 0x1234 500

set addr 0x6789
set value 0b1010

write a32 d16 ${addr} ${value} # -> write a32 d16 0x6789 0b1010
${addr} ${value} # same as above using the short form of the
→˓write command

4.3.3.2 Expressions

Mathematical expressions in VME scripts are enclosed between $( and ). The enclosed string (including the
outermost parentheses) is passed to the exprtk library for evaluation and the resulting value replaces the expression
string before further parsing is done.

exprtk internally uses floating point arithmetic and the result of evaluating an expression is always a floating point
value. It is up to the specific command of how the value is treated.

Variable references inside expressions are expanded before the expression is given to the exprtk library for evalu-
ation.
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Example

# From the MDPP-32-QDC init script: Window start = 16384 + delay[ns] / 1.56;
0x6050 $(16384 - 100 / 1.56)

# or using a local variable to hold the delay:
set my_delay -100
0x6050 $(16384 + ${my_delay} / 1.56)

4.3.4 Example Script

# BLT readout until BERR or number of transfers reached
bltfifo a32 0x0000 10000

# Write the value 3 to address 0x6070. If this appears in a module specific
# script (init, readout, reset) the module base address is added to the
# given address.
0x6070 3

# Same as above but explicitly using the write command.
write a32 d16 0x6070 3

# Set a different base address. This will replace the current base address
# until resetbase is used.
setbase 0xbb000000

# Results in an a32/d16 write to 0xbb006070.
0x6070 5

# Restore the original base address.
resetbase

# Binary notation for the register value.
0x6070 0b0000'0101

4.4 MVLC Trigger I/O Module

4.4.1 Introduction

The MVLC VME controller contains a digitial logic module enabling flexible configuration of readout trigger logic
and timings. The module includes setup of the front-panel NIM IOs and ECL outputs, internal logic functions,
signal routing and access to utilities like timers, counters and the VME system clock.

The low-level setup of the Trigger I/O module is performed by writing to special registers via MVLCs internal
VME interface at base address 0xffff0000. This means standard VME write commands can be used to setup
the module, create software triggers and read out counter values.

mvme contains a dedicated graphical interface representing the structure and internal connections of the logic
module. This interface shields the user from the low-level details, allows to use custom signal names and simplifies
creating complex setups. The low-level VME commands used to setup the logic module can still be viewed and
manually edited if needed.

mesytec GmbH & Co. KG
Wernher-von-Braun-Str.1, D-85640 Putzbrunn, Germany
phone: +49 - 89 / 456007-30 fax: +49 - 89 / 456007-39

info@mesytec.com - www.mesytec.com

26/82



mvme - mesytec VME Data Acquisition

4.4.2 Structure and operation

Fig. 4.3: Structure of the MVLC Trigger I/O module

Logically the MVLC Trigger I/O module is divided into 4 levels with signals originating on the lowest level and
flowing through the system towards the higher levels.

Each of the levels contains a set of specific units representing functionality provided by the logic module. This
includes the NIM I/Os, timers, lookup tables, counters, access to command stacks etc.

The units from higher levels connect back to units from lower levels. Some of these connections are hardwired
while others can be dynamically selected from a set of options.

Level 0 contains signal-generating units like NIM inputs, the VME system clock and timers.

Levels 1 and 2 contain lookup tables which can be used to implement arbitrary boolean logic and route signals to
higher levels.

Level 3 consists of signal-consuming units like NIM outputs, counters and units for executing command stacks.

The delay introduced by the logic module for a signal travelling from a NIM input to a NIM output is ~160 ns.
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4.4.3 User Interface and integration into mvme

Inside mvme the MVLC Trigger I/O module will appear as the topmost item in the VME Config tree when one of
the MVLC variants (USB or Ethernet) is selected as the VME Controller.

Fig. 4.4: VME Config tree with the MVLC Trigger I/O module at the top

Double-clicking this module will open a dedicated GUI representing the current configuration of the logic module.
The view can be zoomed via the mouse wheel and panned by holding down the left mouse button and moving the
cursor.

Each of the blocks can be double-clicked to open an editor window specific to the unit or groups of units. Input
and output pins are represented by small circles near the edges of each block. Connections between pins are drawn
as arrows from source to destination.

The user interface only draws arrows for connections it considers active. NIM and ECL units have their own
activation flags present in the hardware while other units such as timers - which interally are always active - have a
software-only activation flag. Lookup table inputs are only considered active if the corresponding input is actually
used in the logic function implemented by the LUT.

Each of the specific editor windows allows editing the names of input/output pins which makes routing and con-
necting signals easier.

By default changes made in any of the editor windows are applied immediately upon closing the editor or pressing
the Apply button as long as mvme is connected to an MVLC. This means the software representation of the
Trigger I/O module is converted to a list of VME write commands targeting the MVLC and then this command
list is directly executed. Use the Autorun button from the top toolbar to toggle this behaviour.

If you want to view or edit the VME write commands directly use the View Script button, make your changes
inside the text editor that opens up and then press the Reparse from script button to update the user
interface.

Descriptions of the available units and their corresponding GUI editors can be found in I/O and logic units.

When starting a new DAQ run the initialization procedure will apply the current logic setup to the MVLC before
further initializing any modules and setting up the readout stacks.

mesytec GmbH & Co. KG
Wernher-von-Braun-Str.1, D-85640 Putzbrunn, Germany
phone: +49 - 89 / 456007-30 fax: +49 - 89 / 456007-39

info@mesytec.com - www.mesytec.com

28/82



mvme - mesytec VME Data Acquisition

4.4.3.1 Reserved logic units

To implement events that should be periodcally read out mvme reserves the first two timer and stack start units.
Currently these units are not available for modification in the user interface.

Whenever a periodic event is created the first available timer unit is setup with the events readout period. The first
available StackStart unit is then connected to the timer and setup to start the events readout command stack.

Note that if more than two periodic VME events are created, the rest of the Timer and StackStart units will also
be used by mvme. Having more than 4 periodic events defined in the VME config is not allowed and will lead to
an error at startup.

Fig. 4.5: Internal usage of Timer and StackStart units for a periodic VME event called counter_readout.

4.4.4 Gate Generators

Some of the Trigger I/O units have builtin gate generators to influence the signals they produce. These units are
the NIM I/Os, ECL outputs, VME IRQ inputs, LUT strobe inputs and the SlaveTrigger inputs. The gate generators
share a common set of properties:

• Delay

Delays generation of the output pulse by the specified time in nanoseconds.

Minimum: 0 - no delay, maximum: 65535 ns

• Width

The width of the generated pulse in nanoseconds. Setting the width to 0 disables the gate generator.

Minimum: 8 ns, maximum: 65535 ns.

• Holdoff

Holdoff sets the minimum time that must elapse before the next change to the output may occur.

Minimum: 0 ns, maximum: 65535 ns.

• Invert

By default output pulses are generated at the leading edge of the input signal. Setting the invert flag changes
this to the trailing edge.

Each gate generator can be disabled by setting its width to 0. In this case the signal is passed through as is. This
allows to make use of DC-level signals inside the logic (for example busy inputs from external hardware).
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4.4.5 I/O and logic units

4.4.5.1 NIM I/Os

The front panel NIM connectors can be configured as either input or output. This means they are available both
on the level0 input side and on the level3 output side.

Each of the NIM I/Os is driven by a gate generator. When a NIM is configured as an input the gate generator is
used to generate the internal signal. If the NIM is configured as an output the gate generator affects the output
signal of the NIM.

Note that it is possible to use a NIM as both input and output at the same time. In this case the NIM has to be
configured as an output and the gate generator acts on the output signal only.

4.4.5.2 LVDS outputs

These are similar to the NIM output units. Each of the 3 outputs needs to be activated separately.

4.4.5.3 IRQ inputs

In addition to the front panel NIM inputs the Trigger I/O module also provides access to VME IRQs 1-6. Each
IRQ unit is connected to a gate generator just like the NIM inputs. The output signal of the gate generator is
available for further processing in a LUT on level 1.

4.4.5.4 Timers

Fixed frequency logic pulse generation. The generated output pulses have a fixed width of 8 ns. The minimum
period between rising edges is 24 ns.

Settings

• Range

The time unit the timer period refers to. One of ns, µs, ms or s.

• Period

The period in units specified by Range.

Minimum: 24 ns, maximum: 65535 s.

• Delay

Delays generation of the output pulse by the specified time in nanoseconds.

Minimum: 0 - no delay, maximum: 65535 ns

4.4.5.5 Trigger Resource Units

Each TriggerResource can be configured as one of IRQ, SoftTrigger or SlaveTrigger unit types.

IRQ Utility Units

These units generate a signal when one of the 7 available VME IRQs triggers. The only setting is the IRQ number
(1-7) each unit should react to.
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Soft Triggers

Software triggers which can either be permanently activated via the GUI editor or pulsed by executing one of the
folowing VME Scripts:

Software triggers which can be pulsed or permanently activated via a VME write instruction.

Example script:

setbase 0xffff0000 # use the mvlc vme interface as the base address for the
→˓following writes

set trigger_index 0 # valid values: 0-7 (trigger_resource
→˓units)

set trigger_unit $(4 + ${trigger_index}) # Level0 Units 4-11
0x0200 ${trigger_unit} # select the unit
0x0302 0 # write to the soft_trigger output
→˓activation register

# 0: generate a 8ns pulse, 1: set the
→˓output to permanently high

The above script is available in mvme by right-clicking on the Manual directory in the VME Config Tree and
choosing Add Script from Library -> MVLC SoftTrigger.

Slave Triggers

Activates when one of the slave triggers fires. This feature will be available in the future with a special multi-crate
firmware and supporting software.

4.4.5.6 Stack Busy

The stack busy units are active while their corresponding VME command stack is being executed.

In the mvme user interface the command stack numbers are augmented with the event names defined in the VME
config.

4.4.5.7 Sysclk

This unit provides access to the 16 MHz VMEbus system clock.

4.4.5.8 Lookup Tables (Levels 1 and 2)

The MVLC contains a set of lookup tables used to create logic functions and for signal routing. Each lookup table
(LUT) maps 6 input bits to 3 output bits. This allows to e.g. implement 3 functions each mapping 6 input bits to
one output bit or a single 6 to 3 bit function.

Most of the LUT inputs are hardwired while some LUTs have up to three variable inputs. Specifically level1.LUT2
can be connected to either NIM8-10 or IRQ1-3.

The LUTs on level2 connect back to the level1 LUTs and each has three variable inputs which can be connected
to the level1 utility units or certain level1 LUT outputs. Additionally the level2 LUTs each have a strobe input
which is used to synchronize the switching of the LUT outputs.
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Fig. 4.6: The lookup tables with all hardwired connections active.

LUT Editor GUI

Editing of the LUT function is done via its own GUI:
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Fig. 4.7: Editor window for a LUT on Level2.

Elements from top to bottom:

• Dynamic input selection for the first three inputs.

This only appears for LUTs on Level2. The drop down boxes are populated with the possible choices for
each of the dynamic inputs.

• Three columns of LUT functions, one for each of the three LUT output signals.

Each LUT maps 6 input bits to 3 output bits. This means a total of 26 = 64 input combinations per LUT.
To make editing easier only the combinations for selected input bits are shown.

Select the inputs you want to use via the checkboxes under Input Bit Usage. This will populate the
Output Activation table with the correct number of rows to represent each possible input combina-
tion.

Each row of the Output Activation table represents the state of the output for the corresponding
input combination. The input bit combination is shown on each row header with the lowest bit taking the
rightmost place. Click the button to toggle the output state for the corresponding input combination.
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Using the AND, OR and INVERT buttons allows to quickly populate the table with the corresponding func-
tion or invert the current assignment.

• For Level2 LUTs only: strobe input selection and parameters.

For Level2 LUTs an additional Strobe Output checkbox is visible below the function table. If set the
corresponding output bit will be affected by the LUTs strobe input.

The strobe input signal can be selected from a predefined list and its gate generator parameters can be set
using the controls in Strobe Gate Generator Settings.

Note: mvme will attempt to minimize the boolean functions defined by each of the LUTs. This means that not
all selected input bits will necessarily be selected again when next opening the editor window but the resulting
function should be identical.

Example

Fig. 4.8: Example LUT using input bits 0, 2 and 4. The output is activated if exactly two of the inputs are set.
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4.4.5.9 StackStart

These units start the execution of one of the 7 MVLC command stacks.

Settings

• Index of the command stack to execute

• Delay: the delay in ns until the stack execution is started

• Activation flag

In the mvme user interface the command stack numbers are augmented with the event names defined in the VME
config.

4.4.5.10 MasterTrigger

Generates a master trigger in multi-crate setups. This feature will be available in the future with a special multi-
crate firmware and supporting software.

4.4.5.11 Counters

8 64-bit counter units incrementing by one each time the input rises. Each counter has an optional latch input
which atomically transfers the current counter values to the counter registers. The latch can either be activated by
the Trigger/IO module or by writing to a special latch register.

The counter units can be read out via MVCLs internal VME interface at base address 0xffff0000 using the
following VME script:

setbase 0xffff0000

# counter0
0x0200 0x0308 # counter select
0x030a 1 # latch the counter (only needed if not done in the
→˓trigger_io module)
read a32 d16 0x0300 # counter readout
read a32 d16 0x0302
read a32 d16 0x0304
read a32 d16 0x0306

# counter1
/*
0x0200 0x0309 # counter select
0x030a 1 # latch the counter (only needed if not done in the
→˓trigger_io module)
read a32 d16 0x0300 # counter readout
read a32 d16 0x0302
read a32 d16 0x0304
read a32 d16 0x0306

*/

A dedicated VME module called MVLC Timestamp/Counter is provided by mvme to ease setting up a
counter readout. Add an instance of this module to the VME Event where you want to read out the counter,
edit the readout script (under Readout Loop in the user interface) and comment out all the counter blocks
except for the one that should be read out.
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4.4.6 Digital Storage Oscilloscope

Since Firmware FW0018 the MVLC contains a digital storage oscilloscope (DSO) allowing to acquire traces of
the signals on the NIM, IRQ and Level1 utility units. Additionally parts of the internal logic of the Trigger IO
module are simulated based on the sampled data.

Fig. 4.9: DSO user interface

The user interface for the oscilloscope can be accessed using the DSO button in the Trigger IO editor. The left side
of the window is used for controlling the DSO while the right side plots selected traces.

4.4.6.1 Steps needed to acquire traces

1. Press the start DSO button to activate the DSO. No data will arrive yet as no triggers are active.

2. In the trace selection tree open the Samples+Triggers node and use the checkboxes to select at least
one of the signals as triggers for the DSO.

3. Drag traces from the tree to the right side list to make them visible in the plot view.

4. Optionally adjust the pre- and post trigger times and the read interval using the inputs in the top left. These
parameters can be adjusted while the DSO is active.

4.4.6.2 Notes

• The read interval is the software side polling interval. It implicitly affects the update frequency of the plot
view. Setting the spinbox to the lowest value allows taking a single snapshot from the DSO by pressing the
Start DSO button.

• The PreTrigger, PostTrigger and Trigger times are highlighted in the plot using vertical lines.

• Traces that are in the set of triggers are shown in italics in the plot view legend.

• Traces can be reordered via drag & drop in the trace list.
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• Except for the traces under Samples+Triggers all other traces in the system are simulated based off
the sampled data.

• The maximum number of samples per channel the MVLC can provide is limitedk This means high frequency
signals may be cut off before the PostTrigger time. The missing part of these traces is drawn using a red
line signifying an unknown state. Simulation code also produces an unknown state if one of the inputs is
unknown.

• The DSO does not have a noticable impact on DAQ readout performance. But the current version of the
mvme GUI will become sluggish in the case where the DSO is active but no triggers fire. Trying to execute
VME scripts or start the DAQ in this state will be slow. The workaround is to disable the DSO, start the
DAQ and reenable the DSO. This will be fixed in a future mvme release.

4.4.7 Trigger IO Usage Example: Sysclk timestamp readout

This example shows how to create a counter that increments with the VME system clock frequency and to read
out the counter values by creating a periodically triggered readout event.

Only an MVLC is required for this setup to work.

• Start by creating new vme and analysis configs in mvme. Make sure the VME controller type is set to one
of the MVLC variants and that mvme can succesfully establish the connection.

• In the VME Config tree right click the Events node and choose Add Event. Select Periodic as the
condition and accept the dialog.

Creating the VME readout event

• Right-click the newly created event and select Add Module. Use the type drop-down and select MVLC
Timestamp/Counter. Accept the dialog to create a module which will read out Counter0 of the Trigger
I/O module.
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Fig. 4.10: VME Config Tree after creating the event and adding the mvlc timestamp module

• Locate the Multicast DAQ Start/Stop node under the newly created event and double-click the
DAQ Start script it to open an editor window.

Add the following line to the script.

writeabs a32 d16 0xffff6090 1 # reset counters

This will make sure the counters are reset when starting a DAQ run.

• Double-click the MVLC Trigger/IO object in the VME Config tree to open the graphical editor.

• Double-click the L3 Utilities block. In the bottom-left select the input for Counter0 and set it to
sysclk. Also check the Soft Activate checkbox.

Counter connected to sysclk and activated

• Now locate the Analysis UI window in mvme (Shortcut is Ctrl-2). event0 should show up in the Event
drop-down and the mvlc_ts module should be visible. In the top area right-click the mvlc_ts module and
select Generate default filters. Press ok to generate data extraction filters and histograms for
the counter readout data.

• Use the Start button in the top-left area of the main window to start a DAQ run. If everything is setup
correctly the DAQ should start successfully (DAQ State: Running) and an event rate of 1 count/s should be
displayed in the Analysis window for the mvlc_ts.timestamp data source.
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DAQ and analysis stats during a run

• You can reopen the MVLC Trigger/IO object again and verify that mvme used the first timer together
with the first StackStart unit to implement the periodic readout for the event.

Internal Timer and StackStart usage by mvme
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4.5 Analysis

4.5.1 User Guide

4.5.1.1 UI Overview

The Analysis system in mvme is designed to allow

• flexible parameter extraction from raw readout data.

• calibration and additional processing of extracted parameters.

• accumulation and visualization of processed data.

The user interface follows the structure of data flow in the system: the modules for the selected Event are shown
in the top-left tree.

The bottom-left tree contains the raw histograms used to accumulate the unmodified data extracted from the
modules.

The next column (Level 1) contains calibration operators in the top view and calibrated histograms in the bottom
view.

Fig. 4.11: Analysis UI Block Diagram

Note: To get a set of basic data extraction filters, calibration operators and histograms right-click on a module an
select Generate default filters.

User Levels are used to structure the analysis and it’s completely optional to have more than two of them. Addi-
tional levels can be added/removed using the + and - buttons at the top-right. Use the Level Visibility button to
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select which levels are shown/hidden.

The UI enforces the rule that operators can use inputs from levels less-than or equal to their own level. This means
data should always flow from left to right. This restriction does not apply to data sinks in the bottom tree. These
can be freely placed on any userlevel in the bottom tree.

Operators can be moved between levels by dragging and dropping them.

Fig. 4.12: Analysis UI Screenshot
The Calibration for mdpp16.amplitude is selected. Its input is shown in green. Operators using the calibrated data are shown

in a light blueish color.

Selecting an object will highlight its input data sources in green and any operators using its output in blue.

4.5.1.2 Adding new objects

Right-click in any of the views and select New to add new operators and histograms. A dialog will pop up with
input fields for operator specific settings and buttons to select the operators inputs.

Clicking any of the input buttons will make the user interface enter “input select mode”. In this mode valid outputs
for the selected input are highlighted.

mesytec GmbH & Co. KG
Wernher-von-Braun-Str.1, D-85640 Putzbrunn, Germany
phone: +49 - 89 / 456007-30 fax: +49 - 89 / 456007-39

info@mesytec.com - www.mesytec.com

41/82



mvme - mesytec VME Data Acquisition

Fig. 4.13: Input select mode
Adding a 1D Range Filter to Level 2. Valid inputs are highlighted in green.

Click an input node to use it for the new operator. If required fill in any additional operator specific data and accept
the dialog. The operator will be added to the system and will immediately start processing data if a DAQ run or
replay is active.

For details about data extraction refer to Data Sources. Descriptions of available operators can be found in Oper-
ators. For details about 1D and 2D histograms check the Data Sinks section.

4.5.1.3 Working with histograms

1D and 2D histograms are shown in the bottom row of the user interface. Raw 1D histograms are grouped by
module in the bottom-left L0 Raw Data Display area. Higher level data displays are grouped by histogram type.

New histograms can be added by right-clicking in one of the data display areas, selecting New and choosing the
histogram type.

1D

1D histograms can take full arrays as input parameters. Internally an array of histograms of the same size as the
input array will be created.

Double-click on the H1D node to open the histogram array widget:
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Fig. 4.14: 1D Histogram Array Widget

• The histogram index can be changed using the spinbox in the top-right corner.

• Zooming is achieved by dragging a rectangle using the left mouse button. Zoom levels are stacked. Click
the right mouse button to zoom out one level.

• Press the Info button to enable an info display at the bottom-right of the window. This will show the current
cursor coordinates and the corresponding bin number.

• Y-Scale

Toggle between linear and logarithmic scales for the Y-Axis.

• Gauss

Fit a gauss curve through the currently visible maximum value.

• Rate Est.

Rate Estimation feature.

Refer to Rate Estimation Setup for a how-to guide.

• Clear

Clears the current histogram.

• Export

Allows exporting to PDF and various image formats. Use the file type selection in the file dialog to choose
the export format.

• Save

Saves the histogram data to a flat text file.

• Subrange
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Allows limiting the range of data that’s accumulated. Only input values falling within the specified interval
will be accumulated.

This does not affect the histogram resolution: the full range of bins is still used with the limits given by the
subrange.

• Resolution

Change the resolution of the histogram in powers of two from 1 bit to 20 bits.

This will not rebin existing data. Instead the histogram is cleared and new data is accumulated using the
newly set resolution.

• Calibration

This button is enabled if the histograms input is a Calibration Operator and allows to directly modify the
calibration information from within the histogram:

Fig. 4.15: Calibration adjustment from within the histogram display

The two inputs in the Actual column refer to the current x-axis scale. The inputs in the Target column are
used to specify the desired x-axis values.

Click on one of the Actual inputs and then press the Vis. Max button to fill in the x-coordinate of the
currently visible maximum value. Then enter the new x-coordinate value in the Target box and press Apply.

In the example above it is known that the peak should be at x = 600.0. The current x-coordinate of the
peak was found using the Vis. Max button. Pressing Apply will modify the calibration for that particular
histogram.

To see a list of calibration values for each channel open the Analysis UI (Ctrl+2), right-click the Calibra-
tion Operator and select Edit.

• 2D combined view

A combined view of the histograms of an array of parameters can be opened by right-clicking a H1D node
and selecting Open 2D Combined View. This option will open a 2D histogram with one column per 1D
histogram in the array.
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The X-axes of the 1D histograms are plotted on the combined views Y-axis, the values of the histograms
are plotted in Z.

This view allows to quickly see if any or all channels of a module are responding.

Fig. 4.16: 2D Combined View of MDPP-16_SCP amplitude values
Channels 0 and 8 are producing data with visible peaks at around 0 and 230.

2D

2D histograms take two single values as their inputs: the X and Y parameters to accumulate. When selecting the
inputs you will need to expand other operators and select the desired index directly.
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Fig. 4.17: Adding a 2D Histogram
Expand operator outputs and select individual indices for both axes.

Optional range limits can be specified for the axes. If enabled only values falling within the given interval will be
accumulated.

Double-click on a H2D node to open the histogram widget:
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Fig. 4.18: 2D Histogram Widget

• Zooming is achieved by dragging a rectangle using the left mouse button. Zoom levels are stacked. Click
the right mouse button to zoom out one level.

• Press the Info button to show histo and cursor coordinate information at the bottom of the window.

• Z-Scale

Toggle between linear and logarithmic scales for the Z-Axis.

• X- and Y-Proj

Create the X/Y-Projection and open it in a new 1D histogram window. The projection will follow any
zooming/scrolling done in the 2D histogram.

• Clear

Clears the histogram.

• Export

Allows exporting to PDF and various image formats. Use the file type selection in the file dialog to choose
the export format.

• Subrange

Allows limiting the range of data that’s accumulated. Only input values falling within the specified interval
will be accumulated.

This does not affect the histogram resolution: the full range of bins is still used with the limits given by the
subrange.

Can optionally create a new histogram with the specified limits instead of modifying the current one. The
newly created histogram will be added to the analysis.

• Resolution
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Change the resolution of the histograms axes in powers of two from 1 bit to 13 bits.

This will not rebin existing data. Instead the histogram is cleared and new data is accumulated using the
newly set resolution.

4.5.2 System Details

As outlined in the introduction the analysis system is a set of interconnected objects with data flowing from
Sources through Operators into Sinks.

The system is structured the same way as the VME Configuration: VME modules are grouped into events. An
event contains the modules that are read out on activation of a certain trigger condition. The result of the readout
is the modules event data (basically an array of 32-bit words). This module event data is the input to the analysis
system.

When processing data from a live DAQ run or from a listfile replay the analysis system is “stepped” in terms of
events: in each step all the Data Sources attached to a module get passed the modules event data. The task of each
source is to extract relevant values from its input data and make these values available to subsequent operators and
sinks.

After all sources have processed the module event data, the dependent operators and sinks are stepped in order.
Each object consumes its input and generates new output or in the case of sinks accumulates incoming data into a
histogram.

Fig. 4.19: Example analysis dataflow

4.5.2.1 Parameter Arrays

The transport container carrying data between objects is the Parameter Array:

Parameter Array
size unit label
Parameters
0 value valid limits
1 value valid limits
2 value valid limits
. . .
size-1 value valid limits

The size of parameter arrays is determined at analysis startup time and is constant throughout the run. The unit
label is a string which currently can be set through the use of the Calibration Operator. The index of a parameter
in the array is usually the channel address that was extracted from the modules data.

Each parameter has the following attributes:
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• value (double)

The parameters data value.

• valid (bool)

True if the parameter is considered valid, false otherwise.

A parameter can become invalid if for example a data source did not extract a value for the corresponding
channel address or an operator wants to explicitly filter out the address or could not calculate a valid result
for the input value.

• limits (two doubles)

Two double values forming the interval [lowerLimit, upperLimit) that the parameters value
should fall into. This is used by histogram sinks and calibration operators to determine the parameters
range and thus calculate the binning.

4.5.2.2 Connection types

Different operators have different requirements on their input types. The Calibration Operator for example can
use whole parameter arrays as its input, transforms each data value and produces an output array of the same size
as the input size.

Other operators can only act on individual values and thus connect directly to a specific index into the parameter
array. An example is the 2D Histogram Sink: it requires exactly two input values, X and Y, neither of which can
be an array.

Fig. 4.20: Example of different input types

Each Operator implementation decides which types of input connections it accepts. Some operators even change
the type of inputs they accept based on the first input type that is connected (they either accept full arrays for all
their inputs or single values for all their inputs).
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The Analysis UI will highlight valid input nodes in green when selecting an operators input.

4.5.3 Data Sources

Analysis Data Sources attach directly to a VME module. On every step of the analysis system they’re handed all
the data words produced by that module in the corresponding readout cycle. Their job is to extract data values
from the raw module data and produce an output parameter array. Currently there’s one Source implemented: The
Filter Extractor

4.5.3.1 Filter Extractor

The Filter Extractor uses a list of bit-level filters to classify input words and extract address and data values.

Filter Basics

A single filter consists of 32 characters used to match a 32-bit data word. The filter describes the static parts of
the data used for matching and the variable parts used for data extraction. The first (leftmost) character of a filter
line matches bit 31, the last character bit 0.

The following characters are used in filter strings:

Character Description
0 bit must be cleared
1 bit must be set
A address bit
D data bit
others don’t care

The following conventions are used in the default filters that come with mvme:

• X is used if any bit value is allowed.

• O (the letter) is used to denote the position of the overflow bit.

• U is used to denote the position of the underflow bit.

• P is used to denote the position of the pileup bit.

These characters are merely used to make it easier to identify certain bits when editing a filter. With regards to
matching any character other than 0 or 1 means that any bit value is allowed.

Example: The default Amplitude filter for the MDPP-16_SCP:

0001 XXXX PO00 AAAA DDDD DDDD DDDD DDDD

The filter above contains a 4-bit address and a 16-bit data value. The positions of the pileup and overflow bits are
marked using P and O. This helps when adjusting the filter to e.g. match only pileup data (replace the P with a 1).

The number of address bits (A) determine the size of the Filter Extractors output array.

Data extraction from an input data word is done by keeping only the bits matching the address or data mask and
then right shifting to align with the 0 bit.

Note: Address and data bit masks do not need to be consecutive. A0AA will produce 3-bit address values by
gathering all extracted A bits on the right: 0AAA.

Each filter has an optional word index attached to it. If the word index is set to a value >= 0, then the filter can
only produce a match on the module data word with the same index.
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Multiple filter words

The Filter Extractor implementation allows combining multiple 32-bit filters to match and extract data from mul-
tiple input words.

Filters are tried in order. If a previously unmatched filter produces a match no further filters will be tried for the
same data word.

Once all individual filters have been matched the whole combined filter matches and address and data values can
be extracted.

When extracting values the filters are again used in order: the first filter produces the lowest bits of the combined
result, the result of the next filter is left-shifted by the amount of bits in the previous filter and so on.

Note: The maximum number of bits that can be extracted for address and data values is limited to 64.

See Timestamp extraction for an example of how a multiword filter can be used.

Matching and data extraction

During a DAQ run or a replay the Filter Extractor gets passed all the data that was produced by a single module
readout (Event Data). Each data word is passed to the internal filter.

Once the filter has completed Required Completion Count times address and data values will be extracted.

The data value is cast to a double and a uniform random value in the range [0, 1) is added. This resulting value
is stored in the output parameter array at the index specified by the extracted address value.

User Interface

In the Analysis UI right-click a Module and select New -> Filter Extractor to add a new filter.
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Fig. 4.21: Filter Extractor UI

Use the + and - symbols to add/remove filter words. The spinbox right of the filter string lets you specify a word
index for the corresponding filter.

Required Completion Count allows you to specify how many times the filter has to match before it produces data.
This completion count starts from 0 on every module event and is incremented by one each time the complete
filter matches.

If Generate Histograms is checked raw and calibrated histograms will be created for the filter. Unit Label, Unit
Min and Unit Max are parameters for the Calibration Operator.

Predefined filters can be loaded into the UI using the Load Filter Template button.

4.5.4 Operators

The following operators are currently implemented in mvme:

4.5.4.1 Calibration

The calibration operator allows to add a unit label to a parameter array and to calibrate input parameters using
unitMin and unitMax values.

Each input parameters [lowerLimit, upperLimit) interval is mapped to the outputs [unitMin,
unitMax) interval.
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With calibrate():

Out = (In - lowerLimit) * (unitMax - unitMin) / (upperLimit - lowerLimit) + unitMin

Limits can be specified individually for each address in the input array. Use the Apply button to set all addresses
to the global min and max values.

Fig. 4.22: Calibration UI
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Note: Calibration information can also be accessed from adjacent 1D histograms. Refer to Working with 1D
Histograms for details.

4.5.4.2 Previous Value

Outputs the input array from the previous event. Optionally outputs the last input that was valid.

Fig. 4.23: Behaviour of Previous Value over time.

If keepValid is set the output will always contain the last valid input values.

This operator can be combined with the Difference Operator to accumulate the changes of a parameter across
events. See Rate Estimation Setup for an example.

4.5.4.3 Difference

Produces the element-wise difference of its two inputs A and B:
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The output unit label is taken from input A. If A[i] or B[i] are invalid then Out[i] will be set to invalid:

Out.Unit = A.Unit
Out[i].lowerLimit = A[i].lowerLimit - B[i].upperLimit
Out[i].upperLimit = A[i].upperLimit - B[i].lowerLimit
Out[i].value = A[i].value - B[i].value

4.5.4.4 Sum / Mean

Calculates the sum (optionally the mean) of the elements of its input array.

This operator produces an output array of size 1.

When calculating the mean the number of valid input values is used as the denominator.

4.5.4.5 Array Map

Allows selecting and reordering arbitrary indices from a variable number of input arrays.

The mappings are created via the user interface:
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Fig. 4.24: Array Map UI

• Use the + and - buttons to add/remove inputs. The elements of newly added inputs will show up in the left
Input list.

• Select elements in the Input and Output lists and use the arrow buttons to move them from one side to the
other.

Multiple items can be selected by control-clicking, ranges of items by shift-clicking. Both methods can be com-
bined to select ranges with holes in-between them. Focus a list and press Ctrl-A to select all items.

4.5.4.6 1D Range Filter
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Keeps values if they fall inside (optionally outside) a given interval. Input values that do not match the criteria are
set to invalid in the output.

4.5.4.7 2D Rectangle Filter

Produces a single valid output value if both inputs satisfy an interval based condition.

4.5.4.8 Condition Filter

Copies data input to output if the corresponding element of the condition input is valid.

4.5.4.9 Expression Operator

This operator uses the exprtk library to compile and evaluate C-like, user-defined expressions.

The operator supports multiple inputs and outputs. The definition of the outputs is done using an exprtk script,
which means arbitrary calculations can be performed to calculate the number of outputs, their sizes and their
parameter limits.

During analysis runtime a second script, the step script, is evaluted each time event data is available. The script
calculates and assigns parameter values to the operators output arrays.

Details about the syntax and semantics are provided in the online help in the Expression Operator user interface.

4.5.4.10 ScalerOverflow

The ScalerOverflow operator outputs a contiguous value given an input value that overflows. This can be used to
handle data like module timestamps which wrap after a certain time.

4.5.5 Data Sinks

mvme currently implements the following data sinks:
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4.5.5.1 1D Histogram

Accumulates incoming data into 1D histograms. Accepts a full array or an individual value as input. If given a
full array the number of histograms that will be created is equal to the array size.

See Working with 1D histograms for usage details.

4.5.5.2 2D Histogram

Accumulates two incoming parameters into a 2D histogram. On each event input data will only be accumulated if
both the X- and Y inputs are valid.

See Working with 2D histograms for details.
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4.5.5.3 Export Sink

Implements data export to binary files and C++/Python example code generation.

This operator does not create an exported version of all the readout data but instead lets the user select a specific
subset of analysis data arrays - all belonging to modules in the same VME event - to be exported to a binary file on
disk. Additionally skeleton code can be generated and used as a base for reading in the generated file and working
with the data.

For a complete, network-based readout data export including ROOT tree generation see EventServer.
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The Export Sink has a variable number of data input arrays that will be written to disk. Additionally a single
parameter condition input can be used to pre-filter data: output data will only be generated if the condition input
is valid.

For each DAQ run or replay an export file named data_<runid>.bin is generated and the data from each event is
appended to that file. If zlib compression is enabled the extension .bin.gz is used.

The inputs define the layout of the exported data (in the case of the “Plain/Full” format the export file contains
plain, packed C-structs).

Use the “C++ & Python Code” button to generate code examples showing how to read and work with export data.

To compile the C++ code run cmake . && make inside the export directory. The CMake file will try to find a
ROOT installation using the environment variable ${ROOTSYS} and will search for zlib in the standard system
paths.

Most of the generated executables take an export binary file as their first command line argument, e.g:

./root_generate_histos my_run_001.bin.gz

4.5.5.4 Rate Monitor

The rate monitor uses its input values as precalculated rates or calculates the rate using the difference of successive
input values. Rate values are kept in a circular buffer and a plot of the rate over time can be displayed.

Details can be found in the Rate Monitor user interface.

4.5.6 Loading foreign analysis files

Internally VME modules are uniquely identified by a UUID and the module type name. This information is stored
in both the VME and analysis configs.

When opening (or importing from) a “foreign” analysis file, module UUIDs and types may not match. In this
case auto-assignment of analysis objects to VME modules is tried first. If auto-assignment is not possible the
unassigned objects are collected under a special node in the top left tree of the analysis window. Data sources
from these unassigned modules can be dragged onto modules existing in current DAQ setup to assign them.

4.5.7 More UI structuring and interactions

4.5.7.1 Directories

Analysis Directory objects can be created in all but the first userlevels (L > 0). Directories are placed in either
the top or bottom trees and keep that assignment throughout their lifetime. Directories can contain any analysis
objects from the corresponding tree and other subdirectories.

Creating a new directory is done via New -> Directory in the context menu.

A directory can serve as the destination of a Drag and Drop operation. All moved objects will be reparented to
this destination directory.

4.5.7.2 Drag and Drop

Objects can be moved in-between trees by dragging and dropping. Selected objects from the source tree will be
moved to the destination tree. If the destination is a directory all dropped objects will be reparented into that
directory.
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4.5.7.3 Multiselections

By holding Ctrl and clicking analysis objects it is possible to create a (cross-tree) multiselection. Combine holding
Ctrl and Shift at the same time to add ranges of objects to an existing selection.

Note: Cross-tree multiselections do not apply to drag and drop operations as these start and end on specific trees.
Thus using a cross-tree selection as the source of a drag operation would be counterintuitive.

4.5.7.4 Copy/Paste

Object selections can be copied to clipboard by using Ctrl-C or choosing Copy in a context menu.

Pasting is done via Ctrl-V or Paste in a trees or directories context menu.

If a selection containing internally connected objects is pasted the connections will be restored on the newly
created copies of the original objects. This way a network of operators and sinks can be duplicated quickly as only
the “external” inputs will need to be reconnected on the copies.

If a directory has been copied the paste operation will create clones of the directory and all of its subobjects.

Copy/paste of data sources is possible but newly pasted objects will not be assigned to a specific module yet.

4.5.7.5 Import/Export

A way to share parts of an analysis is to export a cross-tree multiselection to file and later on import from file.
Use the Export and Import toolbar entries in the analysis UI to perform these actions.

The behavior is similary to the copy/paste operations: all selected objects will be exported to file. On import clones
of these objects are created, internal connections are restored and all objects are placed in the same userlevels as
their originals.

4.6 JSON-RPC remote control support

MVME uses the jsonrpc specification to implement basic remote control functionality. To enable/disable the
RPC-Server use the “Workspace Settings” button in the DAQ Controls Window and follow the instructions there.

If the RPC-Server is enabled mvme will open a TCP listening socket and accept incoming connections. By default
mvme binds to all interfaces and listens on port 13800.

Requests are currently not length-prefixed, instead data is read until a full JSON object has been received. The
received JSON is then interpreted according to the JSON-RPC spec.

Note: The JSON-RPC batch feature is not supported by the server implementation.

A command line client written in Python3 can be found in the mvme distribution under extras/
mvme_jsonrpc_client.py:

$ python3 extras/mvme_jsonrpc_client.py localhost 13800 getDAQState
---> {"id": "0", "jsonrpc": "2.0", "method": "getDAQState", "params": []}
<--- {"id": "0", "jsonrpc": "2.0", "result": "Running"}

4.6.1 Examples

• Requesting DAQ State:

---> {"id": "0", "jsonrpc": "2.0", "method": "getDAQState", "params": []}
<--- {"id": "0", "jsonrpc": "2.0", "result": "Running"}
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• Starting data acquisition:

---> {"id": "0", "jsonrpc": "2.0", "method": "startDAQ", "params": []}
<--- {"id": "0", "jsonrpc": "2.0", "result": true}

• An error response:

---> {"id": "0", "jsonrpc": "2.0", "method": "startDAQ", "params": []}
<--- {"error": {"code": 102, "message": "DAQ readout worker busy"}, "id": "0",
→˓"jsonrpc": "2.0"}

• Requesting DAQ stats:

---> {"id": "0", "jsonrpc": "2.0", "method": "getDAQStats", "params": []}
<--- {"id": "0", "jsonrpc": "2.0", "result": {"analysisEfficiency": 1,
→˓"analyzedBuffers": 4644, "buffersWithErrors": 0, "currentTime": "2018-06-
→˓14T11:45:21", "droppedBuffers": 0, "endTime": null, "listFileBytesWritten":
→˓0, "listFileFilename": "", "runId": "180614_114412", "startTime": "2018-06-
→˓14T11:44:13", "state": "Running", "totalBuffersRead": 4644, "totalBytesRead
→˓": 6366924, "totalNetBytesRead": 5851300}}

4.6.2 Methods

4.6.2.1 getVersion

Returns the version of MVME running the JSON RPC services.

• Parameters

None

• Returns

String containing version information.

4.6.2.2 getLogMessages

Returns the messages buffered up in the MVME log.

• Parameters

None

• Returns

StringList - List containing the log messages from oldest to newest.

4.6.2.3 getDAQStats

Returns information about the current DAQ run including counter values, the current run ID, listfile output file-
name and start time.

• Parameters

None

• Returns

Object
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4.6.2.4 getVMEControllerType

Returns the type of VME controller in use.

• Parameters

None

• Returns

String

4.6.2.5 getVMEControllerStats

Returns detailed VME controller statistics if available for the current controller type.

• Parameters

None

• Returns:

Object

4.6.2.6 getVMEControllerState

Returns the connection state of the VME controller.

• Parameters

None

• Returns:

String - “Connected”, “Disconnected” or “Connecting”

4.6.2.7 reconnectVMEController

Starts a reconnection attempt of the VME controller. The operation is asynchronous, thus the result will not be
directly available. Instead the controller state needs to be polled via getVMEControllerState to see the
result of the reconnection attempt.

Note: this might in the future be changed to a synchronous version, which immediately returns the result or any
errors that occured.

• Parameters

None

• Returns:

String - “Reconnection attempt initiated”

4.6.2.8 getDAQState

Returns the current state of the DAQ.

• Parameters

None

• Returns String - “Idle”, “Starting”, “Running”, “Stopping” or “Paused”
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4.6.2.9 startDAQ

Starts a new DAQ run. The system must be idle, meaning any previous DAQ runs must have been stopped.

• Parameters

None

• Returns

true on success, error status and additional information otherwise.

4.6.2.10 stopDAQ

Stops the current DAQ run.

• Parameters

None

• Returns

true on success, error status and additional information otherwise.

4.7 EventServer for data export

Currently there are two ways built into mvme which allow readout data to be accessed by external software:

• The Analysis ExportSink which is described in the Analysis reference.

This method should be used when a limited number of analysis data arrays - all belonging to modules in the
same VME event - are to be exported.

• The EventServer component described in this section. It provides export functionality of the complete
event data produced during a DAQ run. The data is transmitted over a TCP network connection.

The EventServer should be used when you want to export all of the data produced by an experiment.

The source code for a minimal example client and for a ROOT client is shipped with mvme.

4.7.1 Overview

The EventServer component is a TCP based network server built into mvme. It uses a custom protocol to transmit
extracted VME module data across the network.

The “extracted” data is produced by the data filters attached to each of the VME modules present in the experiment
setup. E.g. with the default filters for a MTDC-32 module the server will send 32 time values, 2 trigger_times and
a module timestamp.
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Fig. 4.25: MTDC-32 with default data extraction filters.

The server is attached to the analysis side of mvme which means during a live DAQ run it will not slow down the
readout. Instead if the server, or the attached clients, cannot keep up with the readout data rate then the normal
buffer loss mechanism at the core of the mvme DAQ will start to discard data. This means during a live run clients
may only see parts of the data, whereas when replaying from a mvme listmode file all data will be transmitted.

The supplied ROOT client recreates the full VME Event -> VME Module -> Data Array structure present in an
mvme setup using automatically generated ROOT classes. Additionally histograms of the raw parameter values
are created and written to a separate ROOT file.
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Fig. 4.26: ROOT tree structure created from an MTDC-32.

Note: The ROOT client requires ROOT6 and has so far only been tested on Linux.

Note: An example mvme workspace which contains pre-recorded listmode data can be found on our website:
https://mesytec.com/kundendaten/mvme-examples/mvme-example-workspace-01.tar.bz2

This workspace can be used to test the server and client without needing to record your own data first.

4.7.2 Using the EventServer

• In the mvme main window go to Workspace Settings and check the Enable Event Server
box. Optionally enter an IPv4 address or a hostname to bind the server to a specific network interface.

Also enter an Experiment Name in the box at the top of the dialog. This will affect the filenames
produced by the mvme_root_client.

• For a first test the mvme_event_server_example_client can be used. It can be found in the bin/ direc-
tory of the mvme installation. Additionally the source code and a small Makefile are present in share/
mvme_event_server_example_client.

Start the client on the same machine: ./bin/mvme_event_server_example_client
--print-data.
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The client should be able to connect to the server running on localhost.

• Open an example listfile via File -> Open Listfile and also load the analysis from the file so that
some data extraction filters are present.

• Start the replay. The client prints the incoming data to stdout.

If you want to write your own client you can find the protocol definition and implementation of the base Client
class in ${MVME}/include/mvme/event_server/common.

4.7.3 Using the ROOT client

The ROOT client is not shipped in binary form but has to be compiled manually so that it links against the locally
installed version of ROOT.

To build the client run the following shell commands:

cd mvme # cd into the mvme
→˓installation directory
source bin/initMVME # setup the enviroment (
→˓$PATH, $LD_LIBRARY_PATH)
make -C ${MVME}/share/mvme_root_client install # compile and install the
→˓client

You can now create a data directory to hold the generated code and output ROOT files and start the
mvme_root_client from within this directory.

The mvme_root_client works in two modes:

1) In client mode it connects to an mvme instance and receives incoming readout data to produce ROOT output
files.

2) The program replays data from a previously created ROOT output file.

In the first case the data description sent by mvme at the beginning of a run is used to generate ROOT classes.
These classes are then compiled and loaded into the client. Compilation is done using a simple Makefile. The
resulting ROOT library is then loaded via TSystem::Load().

During the run incoming event data is interpreted and used to fill instances of the generated ROOT classes. At the
end of the run the class hierarchy is written to file in the form of TTrees. Additionally raw histograms are created,
filled and written to a separate output file.

In the 2nd case the given input file is opened and mvme specific information is used to locate the previously built
ROOT object library. The library is then loaded like in case 1) and the ROOT objects are filled from the data in
the input file.

In both cases user-editable analysis code (analysis.cxx) is loaded (via dlopen()/dlsym()) and is invoked for
each complete event received from mvme or read from the input file. For each defined VME event the client will
attempt to call a function called analyze_<eventname>(), e.g. analyze_event0().

For details on what the generated classes contain see the <ExperimentName>_mvme.{h,cxx} files. The
base classes are defined in ${MVME}/share/mvme_root_client/mvme_root_event_objects.{h,
cxx}.
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CHAPTER

FIVE

HOW-TO GUIDES

5.1 Rate Estimation Setup

This example shows how to use the rate estimation feature built into 1D histograms. Rate estimation works with
statistical data that forms an exponential function.

In this example and MDPP-16_SCP is used but any mesytec VME module should work. The rate estimation is
setup for channel 8 of the MDPP.

To make use of the rate estimation feature a 1D histogram accumulating the difference between timestamp values
of incoming events needs to be created.

Note: For the module to produce timestamps instead of event counter values the register 0x6038 needs to be set
to 1. mvme does this by default for newly created modules in the VME Interface Settings script.

Steps for creating the histogram:

5.1.1 Timestamp extraction

Add a new Extraction Filter with two filter words to the mdpp16:

0001 XXXX XX00 1000 XXXX XXXX XXXX XXXX any
11XX XXXX XXXX XDDD DDDD DDDD DDDD DDDD any

The first filter word matches on the data word for channel 8: the prefix 0001 identifies a data word, the pattern
00 1000 is used to select channel 8 specifically.

The second filter word is used to extract the timestamp value. The prefix 11 marks an End of Event word which
contains the 30-bit timestamp. Using the D character 19-bits of the timestamp value are extracted.

Set the name of the filter to ts_c8 and click Ok to create the filter.

The complete filter will thus match if there was a data word for channel 8 and the event contained a timestamp
data word.

5.1.2 Timestamp calibration

By default the timestamp is generated using the 16 MHz VME SYSCLK. This means the 19-bit timestamp value
is in units of 16 MHz.

The goal is to convert the value to µs which is easier to use: 219/16 = 219/24 = 215 = 32768.

Thus instead of ranging from
[︀
0, 219

[︀
the timestamp should use the range

[︀
0, 215

[︀
.

To transform the value create a Calibration Operator by right-clicking inside the L1 Processing tree (or any higher
level processing tree) and selecting New -> Calibration. Use the green + button in the top-right corner to add a
new user level if necessary.
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As input select the ts_c8 node created in the previous step. Keep the default name ts_c8.cal. Type µs in the Unit
Label field, set Unit Max to 32768 and press the Apply button. Accept the dialog by pressing Ok.

Fig. 5.1: Timestamp calibration

5.1.3 Making the previous timestamp available

Next right-click in the L1 Processing tree (or any higher level processing tree) and select New -> Previous Value.

As input select the ts_c8.cal node created in the previous step. Make sure the Keep valid parameters box is
checked. Set the name to ts_c8.cal.prev.
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Fig. 5.2: Adding the PreviousValue operator

5.1.4 Histogramming the timestamp difference

Again right-click in one of the processing trees and choose New -> Difference. Set input A to ts_c8.cal and input
B to ts_c8.cal.prev. Set the name to ts_c8.diff.
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Fig. 5.3: Calculating the timestamp difference

Right-click in the display tree below and add a new 1D histogram using the difference ts_c8.diff as the input.

Open the newly created histogram click on Subrange, select Limit X-Axis and enter (0.0, 200.0) as the limits.
This step limits the large default parameter range calculated by the Difference operator.
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Fig. 5.4: Setting the histogram subrange

Next click the Rate Estimation button in the toolbar and then select two points on the x-axis to use for the rate
estimation.
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Fig. 5.5: Rate estimation data and curve visible

The calculation performed is:

𝜏 = (𝑥2 − 𝑥1)/𝑙𝑜𝑔(𝑦1/𝑦2)

𝑦 = 𝑦1 * (𝑒−𝑥/𝜏/𝑒−𝑥1/𝜏 )

𝑓𝑟𝑒𝑒𝑅𝑎𝑡𝑒 = 1.0/𝜏

5.2 VM-USB Firmware Update

The VM-USB firmware update functionality can be found in the mvme main window under Tools -> VM-USB
Firmware Update. The latest firmware file is included in the mvme installation directory under extras/vm-usb.

Before starting the update set the Prog dial on the VM-USB to one of the programming positions P1-P4.

The controller will start the newly written firmware immediately after writing completes. Reset the Prog dial to
C1-C4 to make the controller start the correct firmware on the next power cycle.
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CHAPTER

SIX

CHANGELOG

6.1 Version 1.4.6

• [mvlc] - Improve immediate MVLC/VME command latency when using the DSO. - Trigger/IO updates

• [analysis] - Fix crash in the ExportSink (“File Export”) operator. - Add CSV output option to the Ex-
portSink.

• [vme] Change default vme amods from the privileged to the user variants.

6.2 Version 1.4.5

• Create an empty analysis when opening a workspace and no existing analysis could be loaded from the
workspace. This fixes an issue where analysis objects from the previously opened workspace still existed
after changing the workspace.

6.3 Version 1.4.4

• [vme_script] Behavior changes:

– Do not accept octal values anymore. ‘010’ was parsed as 8 decimal while ‘080’ - which is an invalid
octal literal - was parsed as a floating point value and interepreted as 8 decimal.

– Floating point parsing is now only applied if the literal contains a ‘.’.

• [analysis] Module hit counts in the top left tree now display the count and rate of non-empty readout data
from the module. Previously they showed all hits and where thus equal to parent event rate unless multi-
event splitting was in effect.

• [vmusb] Fix readout being broken.

• Do not auto create non-existing workspace directories on startup. Instead ask the user to open an existing
workspace or create a new one.

• Do not set default vme and analysis config file names when creating a workspace or no previously loaded
files exist in the current workspace. This makes the user have to pick a name when saving each of the files
and should make it less likely to accidentially overwrite existing configs.

6.4 Version 1.4.3

• [mvlc] Add support for the oscilloscope built into the MVLC since firmware FW0018.

• [analysis]
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– Remove the vme module assignment dialog. Instead show data sources belonging to unassigned mod-
ules in a hierarchy in the top left tree of the analysis window. Data sources can be dragged from there
onto known modules to assign them.

– Add static variables to the Expression Operator. These variables exist per operator instance and persist
their values throughout a DAQ or replay run.

– Add a ScalerOverflow operator which outputs a contiguous increasing value given an input value that
overflows. This can be used to handle data like module timestamps which wrap after a certain time.

– The RateMonitor can now display a plain value on the x axis instead of time values. Useful when
plotting timestamp or counter values.

– Added division to the binary equation operator.

• Better handling of vme/analysis config files when opening listfiles to reduce the number of instances where
the vme and analysis configs diverge.

• Add print statements to the module reset vme template scripts.

6.5 Version 1.4.2

• [vme_templates]

– Wait 500ms instead of 50ms in the reset scripts of MDPP-32_PADC/QDC

– Update MDPP-32_QDC calibration to 16 bits

– Do not set vme mcst address in the mvlc_timestamper VME Interface Settings script.

• [analysis]

– Improve Rate Monitor draw performance

– Make Rate Estimation work in projections of 2D histograms

– Analysis session data parsing fixes

6.6 Version 1.4.1

• [vme_templates] Fix gain calculation in MDPP16-SCP Frontend Settings script.

6.7 Version 1.4.0

• [mvlc] Trigger/IO updates for firmware FW0017

– Replace IRQ, SoftTrigger and SlaveTrigger units with the new TriggerResource units

– Support the IRQ input, L1.LUT5/6 and L2.LUT2 units

– Support Frequency Counter Mode for Counter units

– Basic support for the Digital Storage Oscilloscpe built into the Trigger/IO system.

– Crash fixes when parsing Trigger/IO scripts

• [mvlc] Updates to the DAQ Start and Stop sequence

• [vme_config] The order of Modules within an Event can now be changed via drag and drop.

• [analysis]

– Performance and visual updates for the RateMonitors

– Display directory hierarchy in Histogram and RateMonitor window titles
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• [vme_templates]

– Add the new MDPP-16/32 channel based IRQ signalling.

– Add the ‘stop acq’ sequence to all module ‘VME Interface Settings’ scripts. This makes modules not
produce data/triggers directly after being intialized but only after the ‘Event DAQ Start’ script has
been executed.

6.8 Version 1.3.0

• [mvlc] Support MVLC ethernet readout throttling

– Throttling is done by sending ‘delay’ commands to the MVLC which then adds small gaps between
outgoing ethernet packets thus effectively limiting the data rate.

– The MVLC will block the VME readout side if it cannot send out enough ethernet packets either due to
reaching the maximum bandwidth or due to throttling. This behaves in the same way as USB readouts
when the software side cannot keep up with the USB data rate.

– The delay value is currently calculated based on the usage level of the readout socket receive buffer.
Throttling starts at 50% buffer usage level and increases exponentially from there.

This method of ethernet throttling is effective when the receiving PC cannot handle the incoming data rate,
e.g. because it cannot compress the listfile fast enough. Instead of bursts of packet loss which can lead
to losing big chunks of readout data the readout itself is slowed down, effectively limiting the trigger rate.
The implementation does not compensate for packet loss caused by network switches or other network
equipment.

Throttling and socket buffer statistics are shown at the bottom of the main window, below the VME config
tree.

• [mvlc] readout_parser fixes: - disabled VME modules where confusing the readout parser - stale data from
the previous DAQ run was remaining in the buffers

• [mvlc] Updates and fixes for the trigger IO editor.

• [mvlc] When creating a new VME config a new default trigger IO setup is loaded. The setup provides
5 trigger inputs, 5 gated trigger outputs, a free trigger output and daq_start, stack_busy and readout_busy
signals on the NIMs. The setup is intended to be used with two events: one for the readout and one periodic
event for counter readout.

• [analysis] Allow directories, copy/paste and drag/drop for raw histograms (bottom-left tree view). When
generating default filters and histograms for a module the histograms are also placed in a directory instead
of being attached to special module nodes. When loading analysis files from previous versions the missing
directories are automatically created.

• [analysis] Updated the multievent_splitter to work with modules which do not contain the length of the
following event data in their header word. Instead the event length is determined by repeatedly trying the
module header filter until it matches the next header or the end of the readout data is reached.

• [analysis] Updates and fixes for the RateMonitors

• [vme_templates]

– Updates to the mesytec VMMR template.

– Updates to the CAEN v785 template.

– Add templates for the CAEN V1190A Multihit TDC.

• [vme_script] add ‘readabs’ command

• [core] Improve the high level stopDAQ logic and resulting state updates. This in turn makes stopping the
DAQ via JSON-RPC work reliably.
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6.9 Version 1.2.1

• [analyis] Fix two crashes when using the ExportSink

6.10 Version 1.2.0

• [mvlc] Update mesytec-mvlc lib to work around an issue were MVLC_ETH was not able to connect under
Windows 10 Build 2004.

This issue has also been fixed in MVLC Firmware FW0008.

• [vme_templates] Add VME and analysis templates for the mesytec MDPP-16_CSI, MDPP-16_PADC and
MDPP-32_PADC module variants.

• [vme_templates] Add templates for the MDI-2 starting from firmware FW0300.

• [vme_templates] Add files for the CAEN V830 latching scaler.

• [vme_script] Add a new ‘mblts’ (swapped block read) command for the MVLC which swaps the two 32-bit
words received from MBLT64 block reads.

This was added to the MVLC to support the CAEN V830 and possibly other modules which have the data
words swapped compared to the mesytec modules.

• [analysis] Generate histograms and calibrations for ListfilterExtractors found in module analysis template
files. This was added for the V830 which is the first template file to use ListfilterExtractors.

• [core] Add facilities for storing the log messages generated by mvme to disk:

– All messages generated during DAQ runs (from ‘DAQ start’ to ‘DAQ stop’) are written to a file in the
workspace ‘run_logs/’ directory.

The maximum number of files kept is limited to 50. On exceeding the limit the oldest file is removed.
Filenames are based on the current date and time.

This feature was added because previously only the logs from successful DAQ starts where kept on
disk (inside the listfile ZIP archive generated by mvme). Log contents from aborted starts had to be
manually copied from the log window.

– All messages generated by mvme are written to ‘logs/mvme.log’. On opening a workspace an existing
logfile is moved to ‘logs/last_mvme.log’ and a new logfile is created.

These files contain all messages generated by mvme, even those produced while no DAQ run was
active.

• [event_server] Use relative path for dlopen() in mvme_root_client. Attempts to fix an issue where the
analysis.so could not be loaded on some machines.

6.11 Version 1.1.0

• MVLC support is now implemented using the mesytec-mvlc library. Listfiles created by this version of
mvme can be replayed using the library (e.g. the mini-daq-replay program).

6.12 Version 1.0.1

• [vme_templates] Add new VMMR_Monitor module intended for reading out MMR monitor data (power,
temperature, errors).

• [vme_templates] Module templates can now specify a set of default variables to create when the module is
instantiated.
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• [vme_templates] Allow using ListFilterExtractors in module analysis templates in addition to MultiWord-
DataFilters.

• [mvlc] Update trigger io editor connection bars to reflect changes to the firmware.

• [mvlc] Fix potential data loss under very high data rates.

• [doc] Updates to the Installation section.

6.13 Version 1.0.0

• Add ability to run the data acquisition for a limited amount of time before automatically stopping the run.

• Add VME templates for the MDPP-32 (SCP and QDC variants).

• [vme_script] Drop support for the ‘counted block read‘ commands. They are complex, rarely used and the
MVLC does not currently support them. As long as a VME module supports either reading until BERR or
can be read out using a fixed amount of (M)BLT cycles there is no need for these special commands.

• [vme_script] VME scripts now support floating point values, variables and embedded mathematical expres-
sions.

• [vme_config] Updates to the mesytec module templates and the internal config logic to make use of the new
VME script variables.

These changes make IRQ and MCST handling with multiple modules and events much simpler. When using
only mesytec modules no manual editing of scripts is required anymore.

When loading a config file from a previous mvme version all module and event scripts will be updated to
make use of the standard set of variables added to each VME event.

• Improve UI responsiveness with the MVLC at low data rates.

• Multiple MVLC fixes and improvements.

• Various bugfixes and UI improvements

– VME Script error messages are now highlighted in red in the log view.

– Speed up creating and updating the analysis tree views. This is especially noticeable when using many
modules or many VME events.

• Upgrade Qt to version 5.14.1 on the build servers.

• Do not ship libstdc++ with the linux binary package anymore. It caused issues in combination with setting
LD_LIBRARY_PATH as is done in the initMVME shell script.

6.14 Version 0.9.6

• Improved support for the MVLC. Among others VME Scripts can now be directly executed during a DAQ
run without having to pause and resume the DAQ.

• New UI for setting up the MVLC Trigger and I/O logic system.

• Updates to the auto-matching of vme and analysis objects on config load.

• Improved the mvlc_root_client

• Documentation updates

• Improved VME module templates

• Various stability and bugfixes
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6.15 Version 0.9.5.5

• This is the first version with support for the upcoming mesytec MVLC VME controller.

• Added the EventServer component which allows to transmit extracted readout data over a TCP connection.

• Added a client for the EventServer protocol which generates and loads ROOT classes, fills instances of the
generated classes with incoming readout data and writes these objects out to a ROOT file. Additionally user
defined callbacks are invoked to perform further analysis on the data.

6.16 Version 0.9.5.4

• Log values written to the VMUSB ActionRegister when starting / stopping the DAQ

6.17 Version 0.9.5.3

• Allow access to all VMUSB registers via vme_script commands vmusb_write_reg and
vmusb_read_reg

• Fix a crash in Histo1DWidget when resolution reduction factor was set to 0

6.18 Version 0.9.5.2

• Fix a race condition at DAQ/replay startup time

• Remove old config autosave files after successfully loading a different config. This fixes an issue where
apparently wrong autosave contents where restored.

• Rewrite the analysis session system to not depend on HDF5 anymore. This was done to avoid potential
issues related to HDF5 and multithreading.

Note: Session files created by previous versions cannot be loaded anymore. They have to be recreated by
replaying from the original readout data.

6.19 Version 0.9.5.1

This release fixes issues with the code generated by the analysis export operator.

Specifically the generated CMakeLists.txt file was not able to find the ROOT package under Ubuntu-14.04 using
the recommended way (probably other versions and other debian-based distributions where affected aswell). A
workaround has been implemented.

Also c++11 support is now properly enabled when using CMake versions older than 3.0.0.

6.20 Version 0.9.5

Note: Analysis files created by this version can not be opened by prior versions because the file format has
changed.

This version contains major enhancements to the analysis user interface and handling of analysis objects.
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• It is now possible to export an object selection to a library file and import objects from library files.

• Directory objects have been added which, in addition to the previously existing userlevels, allow to further
structure an analysis.

Directories can contain operators, data sinks (histograms, rate monitors, etc.) and other directories.

• Objects can now be moved between userlevels and directories using drag and drop.

• A copy/paste mechanism has been implemented which allows creating a copy of a selection of objects.

If internally connected objects are copied and then pasted the connections will be restored on the copies.

Other fixes and changes:

• New feature: dynamic resolution reduction for 1D and 2D histograms.

Axis display resolutions can now be adjusted via sliders in the user interface without having to change the
physical resolution of the underlying histogram.

• Improved hostname lookups for the SIS3153 VME controller under Windows. The result is now up-to-date
without requiring a restart of mvme.

• Add libpng to the linux binary package. This fixes a shared library version conflict under Ubuntu 18.04.

• SIS3153: OUT2 is now active during execution of the main readout stack. Unchanged: OUT1 is active
while in autonomous DAQ mode.

• The Rate Monitor can now take multiple inputs, each of which can be an array or a single parameter.

Also implemented a combined view showing all rates of a Rate Monitor in a single plot.

• Add new VM-USB specific vme script commands: vmusb_write_reg and vmusb_read_reg which
allow setting up the VM-USB NIM outputs, the internal scalers and delay and gate generators.

Refer to the VM-USB manual for details about these registers.

6.21 Version 0.9.4.1

• Fix expression operator GUI not properly loading indexed parameter connections

• Split Histo1D info box into global and gauss specific statistics. Fixes to gauss related calculations.

6.22 Version 0.9.4

• New: Analysis Expression Operator

This is an operator that allows user-defined scripts to be executed for each readout event. Internally exprtk
is used to compile and evaluate expressions.

• New: Analysis Export Sink

Allows exporting of analysis parameter arrays to binary files. Full and sparse data export formats and
optional zlib compression are available.

Source code showing how to read and process the exported data and generate ROOT histograms can be
generated.

• New: Analysis Rate Monitor

Allows to monitor and plot analysis data flow rates and rates calculated from successive counter values (e.g.
timestamp differences).

• Moved the MultiEvent Processing option and the MultiEvent Module Header Filters from the VME side to
the analysis side. This is more logical and allows changing the option when doing a replay.

• General fixes and improvements to the SIS3153 readout code.
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• New: JSON-RPC interface using TCP as the transport mechanism.

Allows to start/stop DAQ runs and to request status information.

6.23 Version 0.9.3

• Support for the Struck SIS3153 VME Controller using an ethernet connection

• Analysis:

– Performance improvments

– Better statistics

– Can now single step through events to ease debugging

– Add additional analysis aggregate operations: min, max, mean, sigma in x and y

– Save/load of complete analysis sessions: Histogram contents are saved to disk and can be loaded at a
later time. No new replay of the data is neccessary.

– New: rate monitoring using rates generated from readout data or flow rates through the analysis.

• Improved mesytec vme module templates. Also added templates for the new VMMR module.

• More options on how the output listfile names are generated.

• Various bugfixes and improvements

6.24 Version 0.9.2

• New experimental feature: multi event readout support to achieve higher data rates.

• DataFilter (Extractor) behaviour change: Extraction masks do not need to be consecutive anymore. Instead
a “bit gather” step is performed to group the extracted bits together and the end of the filter step.

• UI: Keep/Clear histo data on new run is now settable via radio buttons.

• VMUSB: Activate output NIM O2 while DAQ mode is active. Use the top yellow LED to signal “USB
InFIFO Full”.

• Analysis performance improvements.

• Major updates to the VME templates for mesytec modules.

6.25 Version 0.9.1

• Record a timetick every second. Timeticks are stored as sections in the listfile and are passed to the analyis
during DAQ and replay.

• Add option to keep histo data across runs/replays

• Fixes to histograms with axis unit values >= 2^31

• Always use ZIP format for listfiles
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